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Overview

Congratulations!
You've just purchased History of the World!

History Of The World on CD-ROM was born through

many many months of research and hard work. Our

development team and editorial staff strove to present
accurate, all-encompassing, and authoritative textual
material, and to find and integrate multimedia materials
vermane to the historical documents on the disc. The
following is an explanation of the elements you will use
in your research of World History.

Like History itself, using a CD-ROM and learning its
features involves a great deal of exploration. After
reading the user’s guide, we feel it is best to explore on
your own, to learn how the disc will work best for you.

Getting Familiar With History of the World:

The Database

A database is the large heading of organization on the
disc, and the initial choice you make in your research.
There are six databases on History of the World, and you
will usually want to start here immediately following disc
installation.
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1. History Of The World By Title

Because there are so many titles on History Of The
World, this database is further divided into alphabetical
segments. A “Title” might be a book, like Darwin’s
Decent of Man, a short document, like the “Magna
Charta,” or even something as small as a letter penned by
Abraham Lincoln. Using this database will naturally give
you an overview of the contents of the disc.

There are two titles that will be useful for you to get to
easily. These are Civilization: Past and Present, and World
Civilization: A Global Phenomenon, the two World
Civilization textbooks provided by HarperCollins
Publishers. To access these books, choose “Titles” after the
“Contents” heading, and scroll down to the title of the
textbook in the alphabetical listing. These texts are further
broken down by chapter, as are many of the texts on the
disc.

2. History Of The World By Theme

It is useful to be able to access titles by subject matter
easily. To this end, we've divided the titles into topics, or
“themes” as we refer to them on the database. The ten
most salient themes became the menu for the database,
and are listed alphabetically. They are:

Economics

Exploration, Discovery, and Travel
Overviews and Narratives

People and Letters

Philosophy

Politics

Religion

Science, Technology, and Inventions
Society, Culture, and the Arts

Wars, Conquest, and Battles

You'll find that some titles can be found in more than one
category.

X se &
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3. History Of The World By Region

On this disc, The World has been divided into six areas:
Global History, which includes historical topics that
occur on a worldwide level, Africa, The Americas, Asia,
Europe, and The Pacific Region, which includes
Australia and New Zealand. Each of these areas is further
divided into time period. .

4. History Of The World By Time Period
Our research indicated certain natural divisions of
history into time periods. There are seven Time
classifications:

Overviews of World History

Origins of Civilization........cccccccceceieienneneeto 500 BC
Classical Period ........... 500 BC.....oocveveennato 500 AD
Post-Classical Period ......... 500....ccceerereneeto 1450
The World Shrinks.......... 1450.....c0nenersmeseesst@ 1750
Industrial Period .....ccc.c.... 1750..cc0000iuvensveennneto 1900
Twentieth Century .......... 1900........c0...c...to Present

These time divisions are each broken down by region, and
then by title.

5. History Of The World Pictures, Maps, and
Ilustrations

This disc has over 600 illustrations, maps, photos, and
tables, with a range of subject matter from vintage
engravings of Napoleon, photos of ancient artifacts from
Greece, maps of the migration of neolithic peoples,
paintings of battle landscapes, to a photo of the first
woman appointed to the Supreme Court..

You can access illustrations by choosing the “pictures,
maps, and illlustrations” database from the first menu.

%7(_“ y ™



The figures are listed alphabetically and are indexed in
that way.

You can also access figures by pressing F9 while reading
an article and choosing a figure from the menu on the
PC, or by clicking on “Document” above your article on
the Mac, and choosing a figure from the menu there.

You'll also notice that while browsing through an article,

you come across a caption which describes an illustration
or sound clip. The captions provide valuable information
about the figure and about its relevance to the article you
are reading.

6. History Of The World Speeches and Eyewitness
Accounts.

We were able to obtain many exciting speeches by
famous political figures and riveting eyewitness acounts
of important events from the National Archives in
Washington, DC.

These are accessed in the same way that illustrations are,
and can be halted at any time during play by pressing
[escape]. Please see Appendix 2 for an annotated list of
the sound clips, with, among others, a description of the
portion of an address by Hitler included on the disc.

Search and Browse

On almost every CD-ROM, the Search and Browse
functions are the most important feature to researchers
(aside from the text). It is not enough to know how to
use this feature, one must also understand how the system
Is set up.

Each database has its own set of search criteria. Some
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words are excluded from the search because they are so
common. Obtaining the results of a search containing
these terms would take quite along time! Here is a list of
the most common excluded words. You'll see that they
are primarily prepositions and conjunctions:

After, all, although, also, and, but, can, could, did, during,
each, for, from, had, has, have, however, into, its, may,
more, most, not, of, one, only, other, our, same, should,
some, such, than, that, the, their, there, these, they, this,
those, to, use, used, was, were, when, which, who, with.

Chances are, you won't actually need these words when
conducting a search, because the standard search method
involves broader topic and word ranges. Having an idea
of what excluded words are will explain why you might
summon up an “excluded word” message when performing
a search.

The Search and Browse Menu:

SEARCH: You can initiate a search using four indices.

Word Search
Search for any word on the disc (except excluded words)
at almost any time.

Author Search
All of the authors on History Of The World are indexed.
An author can be a person, persons, or an organization.
Using the Browse function will yield a complete list, last
name first, in alphabetical order. Similarly, conducting a
search by author name will gove you the number of
articles written by the author you've chosen.

2 I —a




Title Search

The words in each title (except excluded words) are
indexed. When using the Browse function, you'll get an
alphabetical list of all of the words in all of the titles.
This is a great way to get a general idea of subject matter.

Subject Search

Subjects on History Of The World are devised by
determining the most common words in any given
article. Each article has up to ten subjects.

BROWSE: The Browse function gives you a list of
words, authors, words found in titles, and words which
are in subjects, with the corresponding number of
occurrences. You can find a word easily by typing it or
just the first part of the word or subject.

Now that you know the basics concerning the use of
History Of The World on CD-ROM, you can understand
the way in which the disc is organized, which will help
you further in your quest for knowledge, and will aid in
your enjoyment of the information presented. We feel
that it is not enough to know what buttons to press or
where to click, you also need to understand the thinking
behind any research resource.

The next two sections explain the technical use of the
disc and then present questions to test your knowledge of
the techniques described in this activity guide.
Information for PC-users is presented first, followed by
instructions for Mac-users.



Introduction-PC

Your CD-ROM is designed to work with all PC and
Macintosh CD-ROM drives that support the 1SO-9660
CD-ROM standard.

This portion of the User’s Technical and Activity Guide
provides information for users of IBM PC-, XT-, AT-, and
PS/2 compatible computers. Instructions for Macintosh
users are at the second tab following the instructions for

PC users.

Your History Of The World package includes:

* One terrific disc already in a protective disc caddy

* One case to keep everything safe and neat.

* One manual and activity guide (what you are
reading now)

® One Warranty / Product Registration Card
(please fill out and mail in for update information,
tech support and special offers)

* Product License information

_11._



System Requirements

You Need:

* An IBM PC-, XT-, AT-, PS/2 or compatible
computer

* A CD-ROM drive that supports the 1SO-9660
standard

* Compatible interface card, cable, and sofrware

® Microsoft extensions, version 2.0 or later

* A minimum of 640K RAM.

* DOS 3.1 or later

In order to take full advantage of the multimedia features
on this disc, we also recommend the following:

* VGA monitor and VGA board for image display

® Speakers or headphones for sound
® Printer recommended, but not required

12
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Installation ‘

Optional Installation Procedure:

If you plan to use History Of The World often you
should follow these installation instructions. Several of
the files from the CD-ROM will be copied to your hard
drive to allow for faster program loading. Use this
method if you have a fixed hard drive (usually C:) with at
least 300K free disc space. You do not need to install
History of the World on your system for it to run
properly, see “Getting Started” for quick start
instructions.

To Install:

1. PLACE disc into your CD-ROM drive.

2. At the prompt, TYPE the letter of your CD-ROM
drive and a colon (z).

3. PRESS [enter].
4. TYPE “SETUP".
5. PRESS [enter] You will be asked on which drive you

want to install DiscPassage®.
a. Press [enter] to accept the default drive -OR-
b. TYPE a new drive letter (:) and PRESS [enter]
6. History of the World is now installed!
To run it, type “DP”

13



| Geting Started |

Easy Install Procedure:

l. PLACE the CD-ROM disc in your CD-ROM

drive.

2. TYPE D:HOW, where D: is the letter of your
CD-ROM drive.

3. The copyright screen will appear .
4. PRESS [enter] to acknowledge your acceptance.

5. The History Of The World introductory screen

will appear, followed by the main screen.

6. To skip the introductory screen, press [F2] after
the copyright screen appears.

NOTE: You may receive context-appropriate “HELP”
at any time by pressing [F1].

14
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‘ The Menu Bar {

There are 5 menu items:

Search, Browse, Contents, Database, and Change/Quit.
Press the right-and left-arrow keys to move among menu
items. As you highlight each menu item, additional
choices pop-up. You may highlight these choices by using
the up-and-down arrow keys, and access them by pressing
[enter].

A. SEARCH - Allows you to find and display

articles that contain just one or a combination
of words, authors, subjects, or titles.

With search you may:
1. FIND all articles containing one specific word.

To Search this way, SELECT “Search Title" or other
index from the main screen.
PRESS [enter].
TYPE a word to be searched.
PRESS [F10] to begin search.
The number that appears under “documents found”
tells you how many articles contain your search word.

PRESS [F10] to see a list of articles which contain
your search term.

SCROLL up or down to locate an article to view.
PRESS [enter] to select a highlighted article.

PRESS [F3] to find your search term within the article.
[t will be highlighted.

15
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PRESS [F10] to find the next occurrence of your
search term.

PRESS [F3] to find the next article which contains
your search term.

2. NARROW your search.
TYPE first search term.
PRESS [enter]
“And” appears to the left. See “Boolean Operators” on
page 17 for other options.
PRESS [enter]
TYPE second search term to narrow your search.
PRESS [F10] to start your search.
The number of articles which conrain both your first and
second search terms will appear under “Combined
Matches”.
You may use up to seven search terms!
To find the next occurrence, use the functions listed above.

3. Use OTHER search techniques.

Wildcards- used for words that have common roots
but different suffixes. The two wildcard characters are
the asterisk (*) and the question mark (7).

asterisk is used as a multi-character place-holder and
may appear only at the end of a word.

e.g., Search term: appl*

... Matches: apple, application, apply.
? question mark is used as a single-character place-holder
and may appear anywhere in the word.

e.g., Search term: wav?

... Matches: wavy, wave.

e.g., Search term: ambitio?

... Matches: ambition.
Only one wildcard per term is permitted.

16
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Phrase searches- Enter the phrase with spaces
between the words in the search field.

Proximity Searches- To find articles containing a word
within a certain number of words from another word, use
this example as a model:

... to find articles that contain “war” within 5 words of
the word “peace”, enter war [5] peace. For this search
function only, be sure to physically type in the opening and
closing brackets around the number.

Boolean Operators- The words “And”, “Or”, and “Not”
are called “Boolean Operators” and are used to make your
search more or less specific. They appear between search
terms.

AND narrows the search by only selecting articles
containing both or more terms entered.

OR broadens the search by selecting articles
containing either term.

NOT narrows the first term but not the second.
OFF disregards the search term.

Use the space bar to toggle between the Boolean
Operators. You may enter up to 7 search terms. The
cumulative number of article matches are displayed
under “combined matches”

B. BROWSE -This function allows you to
review lists of words, authors, subjects, and
titles, and to select corresponding articles for
viewing and printing.

17
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SELECT “Browse Titles” or other index from the
main screen by pressing [enter] when “Browse” is

highlighted.

TYPE your Browse term at the “Find” prompt, or
SCROLL to view all terms. The number listed next to
your Browse term indicates the number of articles
containing your term.

PRESS [enter] to view titles containing your term.
PRESS [F10] to see the first occurrence, and so on.

C. CONTENTS - The Contents function
allows you to review all categories, books, and
articles in the database and to select articles for
viewing and printing. Basically, it’s a Table Of
Contents.

After choosing a database listed above either from the
menu bar or immediately following the Introductory
screen, you will enter a hierarchy of organization that
gets narrower and narrower, thus simplifying your search
further and further.

For example, choosing History Of The World by Region
gives you a list of major regions of the world. Choosing
one region on this list gives you a menu of that region in
different time periods. Choosing a selection on this menu
gives you a title list. Choosing a title gives you a list of
chapters. Choosing a chapter gives you a list of parts
within the chaprer, if appropriate. Choosing a part gives
you an actual article. Although this sounds like a
lengthy process, it is really very quick and easy!

18
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C. DATABASE - The Database function

allows you to limit your menu choices to a
particular database on the disc. Considering the
enormous scope of History Of The World, this
is very handy! Under Database, you will have

six choices:
* History Of The World by Title.
¢ History Of The World by Theme.
* History Of The World by Region.
* History Of The World by Time Period.
* Figures/Images On History Of The World.
* Sound Clips On History Of The World.

Choosing one of these databases by scrolling up or down
and pressing [enter] when your choice is highlighted, will
yield the appropriate categories for that particular
database. For example, choosing History Of The World
by Region will give you another menu which lists regions
of the world.

Upon choosing a database, your Search, Browse, and
Contents activities will be limited to the database you
selected. The Figures and Sound Clip categories will give
you a list of all the figures or all the sound clips on the
disc. You can see/hear a selection by scrolling and
pressing [enter].

E. CHANGE/QUIT - Use this function to exit

from the History Of The World database either to

another CD-ROM disc (by switching discs in a single-

Cl;isc CD-ROM drive), to another CD-ROM drive, or to
OS.
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To change to another disc on the same drive:

PRESS “E” or [Alt-E] to highlight the Change/Quit

menu option.

SELECT “Change CD-ROM disc”.

PRESS [enter].

You may now remove History Of The World and
replace it with other Bureau Development titles, or any
title that is DiscPassage-compatible.

To change to another CD-ROM drive letter, if multiple
drives are being used:

PRESS “E” or [Alt-E] to highlight the Change/Quit
menu option.
SELECT “Change CD-ROM drive”.
PRESS [enter].
TYPE the letter naming the new drive.
The new drive must contain a disc that uses
DiscPassage.

To Get To DOS:

PRESS [Alt-X] followed by “Y” to confirm exit, or

PRESS [esc] until the “Exit DiscPassage” sub menu
selection is highlighted.

PRESS [enter] to Exit.
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Searchable Indices

Search and Browse may be used on four different indices:
Words, Authors, Subjects, and Titles. Some words, such
as “and”, “the”, and “of” are so common that they are
excluded from the indices. When a word is excluded,
the disc will let you know. A list of most of the excluded
words can be found on page 9.

WORDS - Except for excluded words, every word in
every article appears in this index! This index is used
when browsing to see what is useful in the entire
database and for looking for an unusual word. Image and
figure captions are indexed here.

AUTHORS - The author field is the second line in
every article, after the book name. Every word or name
that appears in the author field is a part of the Author
index. For History of the World, most of the authors
are famous historian or historical figures. Since all
articles for a given book have the same author, matches
on Author tend to have either no articles, or many
articles. The Browse, rather than Search function is
more useful here.

SUBJECTS - Every article has 10 subjects, derived from
the 10 words appearing most in a given article. Use this
index to research a popular subject. Using this index,
rather than the Word index, will yield fewer matches,
making your search more focused.

TITLES - Each article’s title appears on the top line of
the screen during the article display. The title is the same
as the article name. Use this index to quickly browse a
popular subject.

21
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Command Prompt Line

The Command Prompt Line appears at the bottom of the
screen when you are looking at an article. With the
functions in this line, you can do many things!

PRESS:

F1 to get help at any time.

F3 to go to the next article within your title oras a
result of your Search/Browse activity.

F7 to Print a document. This will print the full article.
PRESS [Print Screen] (usually F13), to print only
the screen in view .
PRESS [esc] to stop printing , then Q to Quit, R to
reprint from the beginning, or C to continue
printing.

F8 to Copy the article to hard disc or floppy. To get an
article to copy, you must provide a file name. Be
sure to enter the drive, path, and file name. For
Example, to save a copy of the article of a file called
“ARCHERS.TXT” in the root directory of your C:
drive, enter C:\ARCHERS.TXT when asked. You
cannot copy files to a CD-ROM drive.

All articles are under copyright © Bureau
Development, Inc. All Rights Reserved. You have
permission to reproduce small portions of articles
provided you give proper credit and copyright notice.

ESC to exit from whatever screen you are viewing
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‘ Getting Pictures & Sound \

F9 will appear only if there is a figure (picture, table, or
sound) in the article. Pressing F9 will yield a menu
with names of figures or sound clips. SCROLL
up/down to highlight, then SELECT a figure by
pressing [enter]. The picture or table will appear, or
a sound clip will begin to play.

Once again, you need a VGA board and a VGA

monitor to see images. If you have a VGA board
with less than 512 kilobytes of memory (SVGA),
you will not get the full quality display of images.

You need either headphones or speakers to hear
sound clips. Have your external speakers or
headphones plugged into the headphone jack of
your CD-ROM player.

You can also access a list of picture and sound titles
within their individual databases.

™




STUDENT/TEACHER

ACTIVITIES

This Student/ Teacher Activity Section is designed for
you to apply what you've read in the user’s guide in a
practical way. You'll find that the guide makes research
easier, and that the exercises are interesting and
educational.

Aside from learning the mechanics of how to use History
Of The World On CD-ROM, you just might learn

something about a subject you've never encountered!

After reading the guide and following the exercises,
students will be able to research paper topics, librarians
will be able to teach research techniques more easily, and

teachers will be able to assign projects more easily.
In the activity section, you will be able to:

Get Familiar With History Of The World.

Use the Search Function.

Browse a Topic or Other List.
Print a Document.
Copy a Document.

Get Started in Writing A Research Paper.

Feel free to copy the activity pages for your use, but be
sure to credit the source.
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Getting Familiar With History Of The World.

After the snazzy History Of The World opening screen,
you see the list of databases. “History Of The World by
Book Title” is highlighted at the top of the screen.
SCROLL right until you reach “Contents”.

SCROLL down to “Titles A-E".

PRESS [enter].

SCROLL down to the article entitled “Career of
Charlemagne”.

PRESS [enter]

SELECT Part .

PRESS [enter]

l. The father of Charlemagne was

2. You can see a picture of Charlemagne.

Describe what the men in the picture are wearing.

Change the data base to the Region selection.
3. What is the title of the only document about Africa in
the 20th century?

Look at the Concept choice in the database.

4. What menu items would you use to find the Old
Testament? History Of The World By Concept

to to = OId Testament.
5. What is the last book listed under Old Testament?
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Conducting A Search

Choose History Of The World by Title.
Choose the Word index.

6. How many articles mention the word “Columbus”?

View the list of titles (Press F10).
7. Write down the sentence where you find the first

mention of “Columbus”.

8. Who is the author of the article where you find

the next mention of Columbus?

Narrowing your search.

As you learned in the user’s guide, you can narrow
your search by entering another term to look for in
addition to your first term.

After Columbus, on the next line,

Type “compass”.

9. The number of articles concerning both Columbus

and compass are

10. Find out how the compass was being used at the time

of Columbus.

26



11. Find all of the articles on the disc written by

Roosevelt. How many are there?

12. Use Columbus in a Subject search. There are

only articles which use Columbus as a subject.

13. Which article mentions Lief Ericson in the same

sentence as Columbus?

Browsing

SCROLL to the Browse Function in the Title database.
FIND Columbus.

14. The number of articles containing mention of
Columbus is more, less, or the same as the number when

using the Search/Word function?

Use the other indices in the Browse Function.

15. How many articles were written by Charles

Darwin?

16. How many articles have “renaissance” as a subject?
I7. How many articles contain the word “pacific” in their
titles?

18. Name these articles.

27
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Finding Figures

19. List the titles of five pictures having to do with
Mythology.

20. FIND the sound clip of the Apollo 11 mission.
What is the famous quote heard?

Further activities:

Print Chapter V of John Fiske’s Discovery of America.
Print only the first screen of “The Boston-Tea Party”

Copy Chapter III of the Age of Fable to your hard disc;
to a floppy disc.

Write a two-page essay on any topic using the following

techniques; show how you used them:

Search using more than two search terms.
Browse for subject.
Refer to a map.

Use at least three different articles in your research.

28
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Answers:

1. Pepin the Short.

2. The men are wearing tunics.

3. The Boer War.

4. Religion; Judaism.

5. Malachi.

6. 137.

7. “It was to these walls Columbus was called back by the
heroic queen and within them the treaty was concluded
which led to the discovery of the western world.”

8. Washington Irving.

9.17.

10 . no answer.

11. 33.

12. 22,

13. History of Intellectual Development of Europe,
Volume II.

14. the same.

15. 108.

16.9.

17.3.

18. a.Chapter V: Period Between Cook’s Second Voyage
and Pacific Ocean Voyage, b.Asia and the Pacific, c. The
Pacific Rim: New Japans?

19. Any of a number.

20. “One small step for man, one giant leap for mankind”.

29






Introduction-MAC

This CD-ROM is designed to work with all PC and
Macintosh CD-ROM drives that support the 1SO-9660
standards.

This portion of the User/Activity Guide explains

operation, and provides activities for users of Macintosh
computers.

Your History Of The World package includes:

® One rerrific disc already in a protective disc caddy.

® One case to keep everything safe and neat.

® One manual and activity guide.

® One Warranty / Product Registration Card.
(please fill out and mail in for update information,
tech support and special offers)

® Product License information.
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To use History Of The World, you need:

e A Macintosh Plus, SE, SE/30, II, Classic, or LC.

e System Software 6.0.4 or greater.

e Approximately 300K of available hard drive space
or on a floppy drive. (Hard drive recommended).

e Driver software for your CD-ROM drive in your
System folder.

e History Of The World is currently sized to run
with 1 megabyte of RAM, 2 megabytes are
recommended, since this will increase the number
of image files you can display at one time.

¢ The following “init” files in your folder:

Foreign File Access.
[SO-9660 File Access.

Images require:

® 32-bit QuickDraw, as shipped from Apple.

e A monitor and video capability for 640x480
resolution in 256 colors or shades of grey.
For color images you need a color monitor!
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Installation

Optional Installation Procedure:

Follow this procedure if you have a hard drive with at
least 300K free disc space, plan to use History Of The
World often, and want to load the program faster.

Otherwise skip to “Getting Started”.

To install History Of The World:

1. PLACE the disc into your CD-ROM drive.

2. OPEN the CD-ROM icon which appears on your
desktop.

3. LOCATE the DiscPassage icon on the CD-ROM disc.

4. DRAG the DiscPassage icon to the area on your hard
drive where you wish to install it.

5. History Of The World is now installed!

6. To run it, DOUBLE CLICK on the DiscPassage icon.
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Getting Started

Easy Installation Procedure:

To run History Of The World:

1. PLACE the CD-ROM disc into your CD-ROM drive.

2. DOUBLE CLICK on the DiscPassage icon on your
hard drive, or

3. DOUBLE CLICK on the History Of The World disc

icon, and then double click on the DiscPassage icon.

In a moment, the copyright screen will appear, followed
by the History Of The World logo, and then the Search
and Display screen.

An item with a folder icon to the left indicates that there
are more levels beneath.

Select an individual entry by double-clicking its icon or
by highlighting the entry, pulling down the File menu and
selecting Open.

When the Document option is not dimmed, the article

contains a multimedia element, such as a sound clip or a
tigure.
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‘ The Main Menu Bar ‘

The main menu bar has seven options:
File, Edit, Format, Document, Search, Browse, & Find.
The options in brief:

FILE: Save, Print articles, or Quit the program.
EDIT: Cut, Copy, and Paste parts of the document.
FORMAT: Change font, style and size of text.
DOCUMENT: Access Pictures, Tables, Maps, and
Sound Clips.

SEARCH: Find articles containing specific words,
authors, subjects, or titles, then select corresponding
articles.

BROWSE: Review lists of words, authors, subjects,
or titles, then select corresponding articles.

FIND: Locate occurrences of search terms in articles.

The seven major functions in detail:

FILE - Text and images can be viewed, printed
or saved to disc. Several of these options are
available through the File menu on the Menu
bar. History Of The World supports a

clipboard, enabling Cut and Paste operations.

PRINT: Use the Print option from the File menu. The
disc will print the complete article to the printer.
Articles are from 2 to 25 pages in length. You may stop
printing of an article by holding down the command key

[38] and typing [.J(PERIOD).
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COPY: Copy the article to disc or floppy with the Save
option from the File menu. The disc will ask you for the
name and location of the file in which you wish to store
the article. If the file name already exists, you will be
asked if you want to replace it. Use this option to create
“mini-files” for inclusion in a book report, letter, paper, or
research document. Files are in ASCII format and may
be imported into all of the popular word processors.

Other File menu operations:

SAVE: Aside from copying text, images can be saved in
any of several formats, from 1-bit to 32-bit deep PICT
format to MacPaint format.

HELP: Useful tips are available at any time from within
the disc. Simply select Help from the File menu and
choose a topic.

EJECT: From within the disc, you can change the disc
by selecting eject from the File menu. Insert the new
disc, which will become the currently active disc.
Ejecting a disc closes all open windows associated with
that disc.

DISCS: If you are running in a multi-CD-ROM disc
environment (using a Pioneer 6-disc changer for
example), selecting this option will display the titles of all
resident discs. The active one will be checked.

QUIT: To Quit History Of The World and return to
the desktop, select the Quit option from the File menu.
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EDIT - The edit menu provides basic text

editing functions including Cut, Copy, Paste,
Clear, and Select All.

Some of the Edit options are available to make it easier to
perform phrase searching. With Search and Browse
active at the same time, you can save keystrokes by
cutting words from the Browse list and pasting them into
your Search template.

FORMAT - The Format menu on the main text
bar supports various operations on text files.
Once a region of text has been highlighted, you

can change its font, point size and style.

Because the text is read from CD-ROM, which is a read-
only medium, the changes won't be saved. If you want to
keep your changes; first save the file into your hard disc,
then make your changes. The text files are saved in
ASCII format.

How to change the format:

Bring up any article.

HIGHLIGHT a section by clicking where you want the
highlighting to begin, and drag the cursor over to where
you want it to end. RELEASE the mouse button.
SELECT the Font option from the Format menu.
CHANGE the font from Monaco to New York, for
example.

The highlighted text will change to the New York font.

Now Select the Size option, and choose 12 point. The
highlighted text increases in size from 10 point.
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Choose the Style option. You can now change the
structure of the text to suit your needs.

Select the Italics option from the Style menu and the
highlighted text is italicized.

If you wish to save any of your changes, use the Save
option from the File menu, or print them out with the
Print option.

DOCUMENT - The Document menu has
entries for files related to the text you are
viewing. The entries include tables, figures
(photos and other illustrations), maps, and

sound clips.

Making a selection from the Document menu will display
the entry in its own window. You can save pictures to
your hard disc and print pictures from the File menu.

SEARCH - Search prompts for the words or
phrases of interest and displays the list of
articles that match your interests. Use Search
when you want information on a particular
topic or range of topics.

BROWSE - Browse lets you peruse a list of
words and then displays the list of articles
containing any word you choose.

\

TS se &
A



P 2 R
FIND - Find allows you to locate the

occurrences of the search word you selected
with the Search or Browse options.

To find the first appearance of the word, select the [FIND
SEARCH WORD] option. To find other occurrences of
your search word in the article, choose the FIND NEXT
option. If you wish to start a new search, choose the
FIND NEW option.

The Find menu is active when you are viewing a text file.
If you have previously selected a search term from either
Search or Browse, you can highlight that term where it

appears in context by selecting the FIND KEYWORD
option.

To search for a new word or phrase in the text file you are
viewing, select the FIND NEW option. A dialog box will
appear to accept the text of the string you wish to search
for.

FIND NEXT works with the previously selected search
option to find the next occurrence of the given search
rerm.

%Q%
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Search and Browse

The Search Function

The Search function allows you to find and display
articles that contain just one or a combination of words,
authors, subjects or titles.

The simplest search is to find all articles containing a
specific word. From the menu bar, select SEARCH, and
then select WORDS. Enter your search term and press
[return], which will start the search. The number you see
under the heading “Documents Found” is the number of
documents containing your search term. Click on
TITLES to get the list of articles containing your search
term. Double click on any article to view the text.

Return to the Search screen by closing the Article and
Search Word Results windows.

The Browse Function

Browse lets you view the contents of the indexes
contained on the disc. Browse, unlike Search, will accept
only one word, not a phrase.

You can Browse through the word, subject, author, or title
list by scrolling through its contents. Clicking in the
scroll box moves the display down by one page.

You can also type a selection in the browse template at
the top of the window, which will move the browse list to



that entry.

To make a selection, double-click on the entry in the
word list, press [return], or click the Titles button. The
titles of documents containing the browse term will be
displayed. You may view and print upon making a
selection. To see the first occurrence of your browse term,
use the Find menu.

Search and Browse Techniques

Search Types:

Word: to search for a word, simply enter it in the Search
field.

Phrase: to search for a phrase, enter it with spaces
hetween the words in the Search field.

Searchable Indices:

Search and Browse may be performed on four different
indices: Words, Authors, Subjects and Titles. When you
search or browse on any of these, the number of matches
indicates the number of articles containing the match,
not the number of times the word appears. There is no
difference between upper and lower case. Close the
window to clear all fields and to restart your search.
Some words, such as “and”, “the”, “of”, etc., are so
common that they are excluded from the indices. If they
were included, it would take forever to search for them!
If you enter one of these words, you get the message
“Word Excluded”. You can find these listed in the
exclude.wrd file in the DiscPass folder on the CD-ROM
disc. You can open this with any common word
processing program, such as TeachText. For a list of most
of the excluded words, see page 9.

IE/ “::i* s e M,"'_ x?’
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WORDS: Except for excluded words, every word in
every article appears in this index. The words index is
useful in these circumstances:

.. .When browsing to see what’s useful in the database, or
.. .When searching for something uncommon that
probably won’t appear as a subject or title.

Image captions for pictures and tables are indexed, but
not words found within tables.

AUTHORS: The Author field is in the second line of
every article. Every word or name that appears in the
author field is part of the Authors index. For History Of
The World, most authors are famous historians and
historical figures. Since all articles for a given book have
the same author, matches on author tend to have either
no articles or many articles. The Browse function is

therefore more useful than the Search function for finding
Authors.

SUBJECTS: The subject of an article is determined by
the 10 most popular words appearing in the article,
excluding 1-letter and very common words. Use this
index to research a popular subject.

Search the Subjects index to see only those articles that
contain many occurrences of the search term, and search
the Words index to see all of the articles you'd get from
the Subjects index and those that just touch on the
subject.

TITLES: The title of each article appears on the top
line of the screen during article display. The title is
identical to the article name. Title searches are perfect
for a quick browse of a popular subject.

N8 _se_ &
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Getting Pictures & Sound

You can view a list of pictures or sound clips by accessing
the proper Database. From there, just “click-on” any title
to reveal a figure, or to hear a clip.

The “DOCUMENT” function from the MAIN MENU
BAR will also yield a menu of figures pertaining to the
article you are reading. Furthermore, as you read through
an article, you will find a figure caption embedded into
the text, indicating that a figure or clip is available to
view or hear at that point in the text. Use the
DOCUMENT function at this time to view a picture or
hear a sound clip relating to the text you are reading.




STUDENT/TEACHER

ACTIVITIES

This activity section provides exercises for learning how
to use History Of The World. Our most important
advice at the Bureau is: Explore, explore, explore!!!!
You'll find that the disc will work the way you want it to

by exploring and experimenting on your own.

At the opening screen, History Of The World introduces
you to an initial Table Of Contents. With this list, vou
can get a further contents list until you get to an article.
You may first look at History Of The World by TITLE,
which is broken down by alphabet, by REGION, which is
broken down by continent, by THEME, which is broken
down by subject matter, and by TIME PERIOD, which is
broken down by major epochs in World History. You can

also get a list of figures and sound clips, which makes the
Multimedia aspects easy to find.

Now let’s do some homework!! No groaning, this will be
fun!!!




Get started.

At the opening screen, “History Of The World by
Title” will be highlighted. Click On it!

The next menu breaks the titles down further by

alphabet. Click on “Titles A-E”.

You now have a list of all of the titles on History Of The
World that start with A-E.

Scroll to “Career of Charlemagne” Click on it!

Click On Part 1.
|. Who was the father of Charlemagne?

2. You can see a picture of Charlemagne by clicking on

Documents, and then clicking on the figure caption.
Describe the clothing the men are wearing.

Change the database to “History Of The World by
Region”. With this as your starting point:

3. What is the title of the one article about Africa during
the 20th century?

Look at “History Of The World by Concept”.

4. What two menu items would you click on to get to
the “Old Testament™?

5. What is the last book listed under the “Old
Testament”?

"
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Conducting a Search.

Choose “History Of The World by Book Title”

Click on Search.

Click on Search Word.
Find out how many articles mention the word
“Columbus”

6. How many articles mention the word “Columbus”?

Get a list of these titles by clicking on the Titles
rectangle.

7. Write down the sentence where you find the first
mention of Columbus.

8. Who is the author of the article where you find the
next mention of Columbus?

Let’s say the search term “Columbus” is too broad for your
research. You can narrow your search by entering
another term to look for at the same time as your first.

On the next line, after “Columbus” type “Compass”.

9. The number of documents concerning both of these
terms is.....}

Scanning these articles will give you an idea about how
the compass was being used at the time of Columbus.

8 sec &
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Author and Subject Search.
Using the Author search, find out:

10. How many articles list Theodore Roosevelt as the
author?

11. How many articles list “Columbus” as a Subject?

12. Which article mentions Lief Ericson in the same
sentence as Columbus?

Browse.

Click on the Browse function on the menu bar, while in
the “History Of The World By Title” database.

Enter “Columbus” after keyword.

13. The number of articles containing mention of
“Columbus” is:

a. more, b. less, or c. the same as the number you found
when using the Word Search.

Experiment with other indices in Browse Function

14. How many articles were written by Charles Darwin!

15. How many articles have “Renaissance” as a subject?

N‘—"'Z;“ f:
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16. How many articles contain the word “pacific” in the
title?
17. Name these articles.

Documents.

18. List the titles of 5 figures having to do with
Mythology.

19. Find the sound clip of the Apollo 11 moon flight.
Do you recognize the famous line spoken? What is it?

Printing and Copying

If your facility can do so:
I. Print out Chapter V of John Fiske's Discovery of
America.

2. Print only the first screen of “The Boston Tea-Party”.

3. Copy Chapter I1I of the Age of Fable to your hard disc
or to a floppy disc.

Integrating What You’ve Learned

Now that you've gone through the basic exercises, try
writing an essay, one-page or so, using these techniques
and elements:

Browse for your Subject.

Search using three search terms.
Use a map.

Use at least three different articles.

Most of all, have fun learning about History!!!
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Answers:

|. Pepin the Short.

2. The men are wearing tunics.

3. The Boer War.

4. Religion; Judaism.

5. Malachi.

6. 137.

7. "It was to these walls Columbus was called back by the
heroic queen and within them the treaty was concluded
which led to the discovery of the western world.”

8. Washington Irving.

9. 17.

10 . no answer.

11,33,

12. 22.

13. History of Intellectual Development of Europe,
Volume I1.

14. the same.

15. 108.

16. 9.

17. 3.

18. a.Chapter V: Period Between Cook’s Second Voyage
and Pacific Ocean Voyage, b.Asia and the Pacific, c.The
Pacific Rim: New Japans?

19. Any of a number.

20. “One small step for man, one giant leap for mankind”.

.
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Appendix 1
Major Works on History of the World:
95 Theses Description of
Martin Luther Elizabethan England
A Child's History of England William Harrison
Charles Dickens Discovery of America
A History of the John Fiske
Babylonians & Assyrians Federalist Papers
George Goods Alexander Hamilton

A Narrative of the Voyages Round
the World Performed by Captain

Cook

A. Kippis

Account of Egypt
Herodotus

Aristotle’s Politics
Autobiography of
Benvenuto Cellini
Bhagavad-Gita

Bible

Buddhist Writings
Bulfinch's Age of Fable
&Beauties of Mythology
Castilian Days

John Hay

Chronicle of Froissart
Cicero's Orations
Civilizations:

Past & Present

Harper Collins World History Text
Wallbank et al.
Communist Manifesto
Marx & Engles

Conduct of Life
Confucius

Das Kapital

Karl Marx

Declaration of Independence
Decline and Fall of the Roman
Empire

Edward Gibbons
Democracy in America
De Toqueville

Descent of Man

Charles Darwin

French Revolution

Thomas Carlyle

Germany

Tacitus

Great Events by

Famous Historians

History of Australia and Islands
Dunton Larkin

History of Early Rome

Livy

History of Europe

During the Middle Ages
Henry Hallam

History of Genghis Khan
Jacob Abbott

History of Religions
George Foot Moore

History of the

Conquest of Mexico
William Prescott

History of the

Conquest of Peru

William Prescott

History

Herodotus

Holy Roman Empire

James Bryce

Impressions of South Africa
James Bryce

Letter of Amerigo Vespucci
Letter of Columbus

Letters & Addresses of Lincoln
Life of Napolean

Bonaparte

Ida M. Tarbell

Life on the Mississippi
Mark Twain



Mayflower Compact
Memorabilia

Xenophon

QOath and Law

Hippocrates

Origin of the Species
Charles Darwin
Philosophy of History
Hegel

Pioneers in Australia

Sir Henry Johnson
Plutarch’s Lives

Plato’s Republic

Political Writing

Thomas Paine

The Qu'ran

Rollin’s Ancient History 4
Volumes

Rough Riders

Theodore Roosevelt
Sayings of Confucius
Selections from Lucian
Stories of the Great West
Theodore Roosevelt
Term'’s of Lee's Surrender
Robert E. Lee &

Ulysses S. Grant

The State

Woodrow Wilson

True Stories of the

Great War

Francis Miller

Wealth of Nations

Adam Smith

World Civilizations:

The Global Experience
Harper Collins World History Text
Steams. .. etal.articles, documents,
and eyewitness accounts
Dawn of Civilization
G.C.C. Maspero
Compilation of the Earliest Code
Hammurabi

Theseus Founds Athens
Plutarch

The Formation of the Castes in
India

Gustave Le Bon

Fall of Troy

George Grote

Accession of Solomon

George Grote

Building of the Temple at
Jerusalem

Henry Hart Milman

Rise and Fall of Assyria

F. Lenormant

Destruction of Nineveh

E. Chevallier

The Foundation of Rome
Barthold Georg Niebuhr

Prince Jimmu Founds Japan's
Capital

Sir Edward Reed

The Foundation of Buddhism
Thomas W. Rhy-Davids

Pythian Games at Delphi
George Grote

Solon's Early Greek Legislation
George Grote

Rise of Confucius, the Chinese
Sage

R.K. Douglas

Rome Established as A Republic
Henry George Liddell

Institution of Tribunes

Henry George Liddell

The Battle of Marathon

Sir Edward Shepherd Creasy
Invasion of Greece by Persians
Under Xerxes

Herodotus

Defence of Thermopylae
Herodotus

Institution and Fall of the
Decemvirate in Rome

Henry G. Liddell

Pericles Rules in Athens
Plutarch

Great Plague at Athens

George Grote



Defeat of the Athenians At
Syracuse

Sir Edward S. Creasy

Retreat of the 10,000 Greeks
Xenophon

Condemnation and Death of
Socrates

Plato

Brennus Burns Rome

Barthold Georg Niebuhr

Tartar Invasion of China by Meha
Demetrius Boulger

Alexander Reduces Tyre Later
Founds Alexandria

Oliver Goldsmith

The Battle of Arbela

Sir Edward S. Creasy

First Battle Between Greeks and
Romans

Plutarch

The Punic Wars

Florius

Battle of Metaurus

Sir Edward S. Creasy

Scipio Africanus Crushes
Hannibal At Zama And
Subjugates Carthage

Livy

Judas Maccabaeus Liberates
Judea

Josephus

The Gracchi and Their Reforms
Theodore Mommsen

Caesar Conquers Gaul
Napoleon Il

Roman Invasion and Conquest of
Britain

Oliver Goldsmith

Cleopatra’s Conquest of Caesar
and Anthony

John P. Mahaffay
Assassination of Caesar
Niebuhr, Plutarch

Rome Becomes a Monarchy
Henry George Liddell
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Death of Antony and Cleopatra
Henry George Liddell
Germans Under Arminius Revolt
Against Rome

Sir Edward S. Creasy
Germanicus in Germany
Tacitus

The Crucifixion

Frederic William Farrar

The Rise and Spread of
Christianity

Renan, Wise, Newman
Burning of Rome Under Nero
Sienkiewicz, Tacitus
Persecution ot the Christians
Under Nero

Frederic William Farrar

The Great Jewish Revolt
Josephus

Siege and Destruction of
Jerusalem

Josephus

Destruction of Pompeii

Pliny, Lytton

The Jews’ Last Struggle for
Freedom

Charles Merivale

Their Final Dispersion
Charles Merivale

Martyrdom of Polycarp and
Justin Martyr

Haversham Cox, Polycarp
Polycarp's Epistle to the
Philippians

Polycarp

Persecution of the Christians in
Gaul

Francois P. G. Guizot

Beginning of Rome’s Decline
Edward Gibbon

Commodus

Edward Gibbon

Eventful Reign of Sapor |, King of
Persia

George Rawlinson



Conversion of Constantine
Johann L. Von Mosheim

Decline of Paganism

Johann L. Von Mosheim

First Nicene Council

Mosheim and Arthur P. Stanley
Rise and Decline of Arianism
Mosheim and Arthur P. Stanley
Foundation of Constantinople
Edward Gibbon

Julian the Apostate Becomes
Emperor of Rome

Edward Gibbon

The Huns and Their Western
Migration

Marcellinus

Final Division of Roman Empire
J.B. Bury

The Disruptive Intrigues

J. B. Bury

Visigoths Pillage Rome

Edward Gibbon

Huns Invade the Eastern Roman
Empire Attila Dicates a Treaty of
Peace

Edward Gibbon

The English Conquest of Britain
John R. Green, Charles Knight
Attila Invades Western Europe
Sir Edward S. Creasy

Battle of Chalons

Edward Gibbon

Foundation of Venice

Thomas Hodgkin, John Ruskin
Clovis Founds the Kingdom of
the Franks, It Becomes Christian
Francois P. G. Guizot
Publication of the Justinian Code
Edward Gibbon

Augustine’s Missionary Work in
England

The Venerable Bede, John R.
Green

The Hegira: Career of Mahomet
Washington Irving

The Koran: and Mahometan
Creed

Simon Ockley

Saracens Conquer Egypt,
Destruction of Library at
Alexandria

Washington Irving

Evolution of Dogeship in Venice
William C. Hazlitt

Sacarens in Spain

Battle of the Guadalete
Ahmed Ibn Mahomet al-Makkari
Battle of Tours

Sir Edward Creasy

Founding of the Carlovingian
Dynasty, Pepin the Short
Threatens the Papal Power
Horace K. Mann

Career of Charlemagne
Francois P. G. Guizot

Egbert Becomes King of the
Anglo-Saxon Heptarchy

David Hume

Feudalism: Its Frankish Birth
and English Development
William Stubbs

Decay of the Frankish Empire
Division into Modern France,
Germany and Italy

Francois P.G. Guizot

Career of Alfred the Great
Thomas Hughes, John R. Green
Henry the Fowler Founds the
Saxon Line of German Kings
Wolfgang Menzel

Origin of the German Burghers
or Middle Classes

Wolfgang Menzel

Conquest of Egypt by the
Fatimites

Stanley lane-Poole

Growth and Decadence of
Chivalry

Leon Gautier

Conversion of Vladimir the Great
AN. Mouravieft
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Introduction of Christianity into
Russia

A. N. Mouravieff

Lief Ericson Discovers America,
Saga of Eric the Red

Charles C. Rafn ,

Mahometans in India

Alexander Dow

Bloody Invasions Under Mahmud
Alexander Dow

Canute Becomes King of England
David Hume

Henry lll Deposes the Simoniacal
Popes Appoints Clement Il
Pontiff

Ferdinand Gregorovius
Dissension and Separation of the
Greek and Roman Churches
Henry F. Tozer

Norman Congquest of England
Sir Edward S. Creasy

Battle of Hastings

Sir Edward S. Creasy

Triumphs of Hildebrand “The
Turning Point of the Middle
Ages”, Henry IV Begs for Mercy
at Canossa

Arthur R. Pennington

Completion of the Doomsday
Book

Charles Knight

Decline of the Moorish Power in
Spain

S. A. Dunham

Growth and Decay of the
Almoravide and Almohade
Dynasties

S.A. Dunham

The First Crusade

Sir George W. Cox

Foundation of the Order of
Knights Templar

Charles G. Addison

Stephen Usurps the English
Crown,

His Conflicts With Matilda,
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Decisive Influence of the Church
Charles Knight

Antipapal Democratic Movement
Johann A. W. Neander

Arnold of Brescia, St. Bernard
and the Second Crusade
Johann A. W. Neander

Decline of the Byzantine Empire
George Finlay

Ravages of Roger of Sicily
George Finlay

Archiepiscopate of Thomas
Becket, His Defence of
Ecclesiastical Jurisdiction, His
Assassination

John Lingard

The Peace of Constance Secures
the Liberties of the Lombard
Cities

Erest P. Henderson.

Saladin Takes Jerusalem from
the Christians

Sir George W. Cox

The Third Crusade

Henry Von Sybel

The Teutonic Knights, Their
Organization and History

F. C. Woodhouse

Philip of France Wins the French
Domains of the English Kings
Kate Northgate

Founding of the Mongol Empire
By Genghis Khan

Henry H. Howorth

Venetians and Crusaders Take
Constantinople, Plunder of
Sacred Relics

Edwin Pears

Latin Empire of the East, Its
Foundation and Fall

W..J. Brodribb

Sir Walter Besant

Innocent Il Exalts the Papal
Power

T.F. Tout
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Signing of Magna Charta
David Hume

The Golden Bull , “Hungary’s
Magna Charta”

E.O.S.

Russia Conquered by the Tartar
Hordes, Alexander Nevski Saves
the Remnant of His People
Alfred Rambaud

The Sixth Crusade, Treaty of
Frederick |l with the Saracens
Sir George W. Cox

Rise of the Hanseatic League

H. Denicke

Mamelukes Usurp Power in Egypt
Sir William Muir

The “Mad Parliament”, Beginning
of England's House of Commons
John Lingard

Louis IX Leads the Last Crusade
Joseph Francos Michaud

Height of Mongol Power in China
Marco Polo

Founding of the House of
Hapsburg

William Coxe

Edward | Conquers Wales
Charles H. Pearson

Japanese Repel the Tartars
Edward H. Parker. Marco Polo
The Sicilian Vespers

Michelle Amari

Expulsion of Jews from England
Henry Hart Milman

Exploits and Death of William
Wallace, the "Hero of Scotland”
Sir Walter Scott

First Great Jubilee of the Roman
Catholic Church

Ferdinand Gregorovius

Dante Composes the Divina
Commedia

Richard William Church

Third Estate Joins the
Government of France

Henri Martin
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War of the Flemings with Philip
the Fair of France

Eyre Evans Crowe

First Swiss Struggle For Liberty
F. Grenfell Baker

Battle of Bannockburn

Andrew Lang

Extinction of the Order of
Knights Templars, Burning of
Grand Master Molay

Henry Hart Milman

James Van Artevelde Leads a
Flemish Revolt, Edward Il of
England Assumes the Title of
King of France

Francois P.G. Guizot

Battles of Sluys and Crecy

Sir John Froissart

Modern Recognition of Scenic
Beauty, Crowning of Petrarch at
Rome

Jacob Burckhardt

Rienzi's Revolution in Rome
Richard Lodge

Beginning and Progress of the
Renaissance

John Addington Symonds

The Black Death Ravages Europe
J.F.C. Hecker, Giovanni Boccaccio
First Turkish Dominion in
Europe, Turks Sieze Gallipoli
Joseph Von Hammer-Purstall
Conspiracy and Death of Marino
Falieri at Venice

Margaret Oliphant

Charles IV of Germany Publishes
His Golden Bull

Sir Robert Comyn

Insurrection of the Jacquerie in
France

Sir John Frossiart

Conquests of Timur the Tartar
Edward Gibbon

Dancing Mania of the Middle
Ages

J.F.C. Hecker



Election of Antipope Clement VII,
Beginning of the Great Schism
Henry Hart Milman

Genoese Surrender to Venetians
Henry Hallam

Rebellion of Wat Tyler

John Lingard

Wycliffe Translates the Bible into
English

J. Paterson Smythe

The Swiss Win Their
Independence

Battle of Sempach

F. Grenfell Baker

Union of Denmark, Sweden, and
Norway

Paul C. Sinding

Deposition of Richard I, Henry IV
Begins the Line of Lancaster
John Lingard

Discovery of the Canary Islands
and the African Coast, Beginning
of the Negro Slave Trade

Sir Arthur Helps

Council of Constance

Richard Lodge

Trial and Burning of John Huss,
The Hussite Wars

Richard Chenevix Trench

The House of Hohenzollern
Established in Brandenburg
Thomas Carlyle

Battle of Agincourt, English
Conquest of France

James Gairdner

Jeanne d'Arc’s Victory at Orleans
Sir Edward S, Creasy

Trial and Execution of Jeanne d'
Arc

Jules Michelet

Charles VIl Loses His Pragmatic
Sanction, Emancipation of the
Gallican Church

W. Henley Jervis

Luther Begins the Reformation in
Germany

Julius Koestlin

Negro Slavery in America, Its
Introduction by Law

Sir Arthur Helps

First Circumnavigation of the
Globe

Joan Bautista

Magellan Reaches the Ladrones
and Philippines

Antonio Pigafetta

The Field of the Cloth of Gold
J.S. Brewer

Cortez Captures the City of
Mexico

William H. Prescott

Liberation of Sweden

Eric Gustave Geijer

The Peasants’ War in Germany
J. H. Merle D'Aubigne

France Loses Italy

William Robertson

Battle of Pavia

William Robertson

Sack of Rome By Imperial Troops
Benvenuto Cellini

Great Religious Movement in
England, Fall of Wolsey

John Richard Green

Pizarro Conquers Peru

Hernando Pizzaro, William Prescott
Calvin is Driven From P-ris, He
Makes Geneva the Stronghold of
Protestantism

AM. Fairbairn

England Breaks With The Roman
Church, Destruction of
Monestaries

John Richard Green

Cartier Explores Canada

H.H. Miles

Mendoza Settles Buenos Aires
Robert Southey



Founding of the Jesuits

Isaac Taylor

De Soto Discovers the
Mississippi

John S.C. Abbott

Revolution of Astronomy by
Copernicus

Sir Robert Stawell Ball

Council of Trent And The
Counter-Reformation

Adolphus W. Ward

Protestant Struggle Against
Charles V, The Smalkaldic War
Edward Armstrong

Introduction of Christianity into
Japan

John H. Gubbins

Collapse of the Power of Charles
V, France Seizes German
Bishoprics

Lady C.C. Jackson

The Religious Peace of Augsberg,
Abdication of Charles V

William Robertson

Akbar Establishes the Mogul
Empire in India

J. Talboys Wheeler

Henry Hudson Explores The
Hudson River

Henry R. Cleveland

Galileo Overthrows Ancient
Philosophy, The Telescope and
Its Discoveries

Sir Oliver Lodge

The Beginning of British Power in
India

Beckles Willson

The Dutch Settlement of New
York

David T. Valentine

Harvey Discovers the Circulation
of the Blood

Thomas H. Huxley

The “Defenestration” at Prague,
The Thirty Years' War

Samuel R. Gardiner
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The First American Legislature
Charles Campbell

Introduction of Negroes into
Virginia

Charles Campbell

Spread of Slavery and Cultivation
of Tobacco

John M. Ludlow

English Pilgrims Settle at
Plymouth

John S. Barry

The Birth of Modern Scientific
Methods, Bacon And Descartes
George Henry Lewes

Siege of La Rochelle

Richelieu Rules France

Andrew D. White

The Great Puritan Exodus to New
England, The Founding of
Boston

John G. Palfrey

Triumph and Death of Gustavus
Adolphus at Luetzen

Benjamin Chapman

Recantation of Galileo

Sir Oliver Lodge

The Educational Reform of
Comenius

Simon Somerville Laurie

The First Written Free
Constitution in the World,
Earliest Union Among American
Colonies

John Marshall

Abolition of the Court of Star-
Chamber

Henry Hallam

The Popular Revolt Against
Charles |

Lord Macaulay

The Founding of Montreal
Alfred Sandham
Presbyterianism Established
Meeting of the Westminster
Assembly

David Masson



Masaniello’s Revolt at Naples
Alfred Von Reumont

The Peace of Westphalia, The
War of the Fronde

Arthur Hassall

Religious Toleration Proclaimed
in Maryland

G. L. Davis

The Great Civil War in England,
The Execution of Charles |

Lord Macaulay

Cromwell's Campaign in Ireland
Frederick Harrison

Moliere Creates Modern Comedy
Henri Van Laun

Cromwell's Rule in England, The
Restoration

Thomas Carlyle, Samuel Pepys
John Law Promotes The
Mississipi Scheme

Louis Adolophe Theirs

Prince Eugene Vanquishes the
Turks, Siege and Battle of
Belgrad

Prince Eugene of Savoy

Bursting of the South Sea Bubble
Louis Adolphe Thiers

Bach Lays the Foundation of
Modern Music

Henry Tipper

Settlement of Georgia

William B, Stevens

Rise of Methodism, Preaching of
the Wesleys and of Whitefield
William E.H. Lecky

Conquests of Nadir Shah,
Capture of Delhi

Sir John Malcolm

First Modern Novel

Edmund Gosse

Frederick the Great Siezes Silesa,
Maria Theresa Appeals to the
Hungarians

William Smyth
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Defeat of the Young Pretender at
Culloden, Last of the Stuarts
Justin McCarthy

Benjamin Franklin Experiments
With Electricity

John Bigelow &Benjamin Franklin
Voltaire Directs European
Thought From Geneva

John Morley, George W. Kitchen
Braddock’s Defeat

George Washington, Winthrop
Sargeant

Exile of Acadian Neutrals
William H. Withrow

Clive Establishes British
Supremacy in India, Black Hole
of Calcutta: Battle of Plassey
Sir Alexander J. Arbuthnot

Seven Years' War

Wolfgang Menzel

Victory of Wolfe at Quebec

A. G. Bradley

Usurpation of Catharine Il in
Russia

W. Knox Johnson

Conspiracy of Pontiac

E. O. Randall

American Colonies Oppose
Stamp Act

James Grahame

Patrick Henry’s Speech

George Bancroft

Watt Improves the Steam-engine
Francois Arago

First Partition of Poland

James Fletcher

The Boston Tea Party

George Bancroft

Cotton Manufacture Developed
Thomas F.Henderson
Intellectual Revolt of Germany
Goethe's “Werther" Arouses
Romanticism

Karl Hildebrand
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Pestalozzi's Method of Education
George Ripley

The Invention of the Telegraph
Charles F. Home

Repeal of the English Corn Laws
Justin Mc Carthy

The Discovery of Neptune

Sir Oliver Lodge

The Acquistition of California
Henry B. Dawson

The Fall of Abd-el-Kader

Edgar Sanderson

The Mexican War

John Bonner

Famine in Ireland

Sir Charles Gavan Duffy
Migrations of the Mormons
Thomas L. Kane

The Reforms of Pius IX ,His Flight
From Rome

Francis Bowen

The Revolution of February in
France

Francois P.G. Guizot
Revolutionary Movements in
Germany

C. Edmund Maurice

The Revolt of Hungary

Adrminius Vambery

The Discovery of Gold in
California John S. Hittell

The Rise and Fall of the Roman
Republic

Jessie White Mario

Livingstone’s African Discoveries
David Livingstone, Thomas Hughes
The Coup d’ Etat of Louis
Napoleon

Alexis De Tocqueville

The Discovery of Gold in
Australia

Edward Jenks

The Rise of the Republican Party
Abraham Lincoln
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The Opening of Japan

Matthew C. Perry

The Capture of Sebastopol

Sir Edward B. Hamley

The Indian Mutiny

J. Talboys Wheeler

The Battles of Magenta and
Solferino

Pietro Orsi

Darwin Publishes His Origin of
Species

Charles Robert Darwin

The Kingdom of Italy Established
Giuseppe Garibaldi,

John Webb Probyn

The Emancipation of Russian
Serfs

Andrew D. White, Nikolai Turgenieff
Secession of the Southern States
Jefferson Davis, Abraham Lincoln
The Battle of Bull Run

Horace Greeley

The Monitor and The Merrimac
John Denison Champlin

The Capture of New Orleans
Loyall Farragut

McClellan's Peninsula Campaign
Rossiter Johnson

Emancipation in the United
States

Abraham Lincoln

The Battle of Gettysburg

Orville J. Victor, Abraham Lincoln
The Fall of Vicksburg

Charles A. Dana and James H.
Wilson

Destruction of Alabama

John Ancrum Winslow, Raphael
Semmes

Sherman's March to the Sea
Rossiter Johnson

Career of the International
Thomas Kirkup

The Surrender of Lee

Ulysses S. Grant
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The Austro-Prussian War
Charles A. Fyffe

The Laying of the Atlantic Cable
Cyrus W. Field

The Fall of Maximilian

Charles A. Fyffe, Prince Salm-Salm
Canadian Confederation

J. Edmund Collins

The Purchase of Alaska
Charles Sumner

The Discovery of Diamonds in
Africa

Gardner F. Williams

Revolution in Spain

William |. Knapp

The Abolition of Fur Companies
G. Mercer Adam

The Opening of the Suez Canal
Gardiner Greene Hubbard

The Completion of the Pacific
Railroad

John P. Davis

The Battle of Sedan

Helmuth Von Moltke, Otto Von
Bismarck

Completion of Italian Unity
Pietro Orsi

The Third French Republic
Jules Favre

The Siege of Paris and the End of
the Franco-Prussian War
Charles F. Horne

The Unification of Germany
Emil Reich

The Rising of the Commune
Gabriel Hanotaux

The Geneva Arbitration
Theodore Dwight Woolsey

The Russo-Turkish War
Wilhelm Mueller

The Berlin Congress

Stephen P.H. Duggan

The First Combat Between
Modern Ironclads

Clements R. Markham

The Capture of Lima
Clements R. Markham
Nihilism

Sergius Stepniak

England in Egypt

James Franck Bright

The Consolidation of Germany
Charles Lowe

France in Annam

Sir Robert Kennaway Douglas
New Japan

Baron Yoshitami Sannomiya,
Tokiwo Yokio, Marquis Hirobumi Ito
The War Between China and
Japan

J. Macgowan, Jukichi Inouye
Arctic Exploration

Albert H. Markham, Ernest A. Man
ltaly in Africa

Frederick Augustus Edwards
The War Between Greece And
Turkey

Sir Ellis Ashmead Bartlett

The Battle of Manila Bay
Hubert Howe Bancroft

The Battles of Santiago
Andrew S. Draper

The Annexation of Hawaii
Edmund James Carpenter
The Peace Conference at the
Hague

Thomas Erskine Holland

The Boer War

A. Conan Doyle, James F.J.
Archibald

The Boxer War

George Lynch and Chuan-Sen
Australian Confederation

J. Grattan Grey

The Panama Canal

A. Maurice Low, Chauncey M.
Depe



Appendix 2
Sound Clips on History of the World

The significance of the events described in the sound
clips on the disc cannot be understated. From one of
the first recordings of the human voice to a recording of
the voice of the first man to walk on the moon, the
excitement felt by the speaker can now be experienced
almost first hand, and through CD-ROM, within the

context and scope of textually recorded history.

The following describes the clips included on the disc,
so that you can learn while listening.

1. Admiral Richard E. Byrd, Antarctic explorer, commanded
many expeditions in both the Arcric and Anrarctic regions.
He was awarded the Congressional Medal of Honor for his
1926 flight over the North Pole. In 1928, he established a base
in Antarctica called Little America, leading four expeditions
there, the last ending in 1956. In this clip, recorded in 1954,
Byrd discusses these expeditions, with an emphasis on future
expeditions and their benefits.

2. Adolph Eichmann, a German Nazi Official, supervised the
hunting and extermination of Jews in World War II. After the
war, he escaped to Argentina, but was abducted and brought to
[srael in 1960, where he was tried and hanged for his crimes.
The Eichmann clip is from his trial.

3. Air Troops in Korea. In this clip, four United States Air
Force pilots describe the defeat of a large formation of
Communist aircraft. During 1950-1953, the Korean War
raged, after North Korea invaded South Korea. A U.S.
dominated UN coalition came to the aid of South Korea, while
the USSR responded to the cry of North Korea for military aid,
a reflection of the continuing Cold War between the U.S. and
the USSR
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Churchill and Truman. This clip, recorded in Washington,
D.C., welcomes Prime Minister Churchill to the U.S., where
he delivers a speech concerning his mission of peace and hope.
Franklin D. Roosevelt. In this speech against war delivered in
Madison Square Garden in 1936, Roosevelt reflects upon the
current conditions of war. President from 1933-1945, he led
the nation through most of World War II, but as Commander-
in-Chief, he had hoped to keep the U.S. out of the war, while
conceding that the nation should be prepared. Gradually,
Roosevelt increased U.S. presence on first British bases, and
then by supplying arms to Britain.

Franklin D. Roosevelt. He delivered this speech concerning
Pearl Harbor in 1941, following the Japanese attack on the
base on December 7, 1941. This action, and Germany's
declaration of war gave Roosevelt a new sense of mission after
months of indecision caused by divided U.S. public opinion
about involvement in the war.

Henry M. Stanley, a British-American journalist who
achieved fame in 1871 when he found the explorer David
Livingstone in Ujiji (Tanzania), later he returned to Africa to
explore Lakes Tanganyika and Victoria and to find the source
of the Congo. In the clip, Stanley speaks through Edison's
phonograph, welcoming the President to Canada.
Hindenberg. Originally called the L.Z. 129 (Luftschiffbau
Zeppelin), and built in Germany in 1936, the Hindenburg was
the world's first transatlantic airliner. The first scheduled
airservice across the North Atlantic occurred in May 1936,
between Frankfurt am Main and Lakehurst, N]J. With more
than seventy passengers, it had a dining room, a library, and a
lounge. The flight took 60 hours. Later the ship would hold
1,300 passengers. Tragically, while positioning to land in
Lakehurst on May 6, 1937, the hydrogen contained within the
ship ignited and the ship was destroyed. Thirty-five died, and
the accident ended the use of airships in air commerce.
Hiroshima. The atomic bomb dropped by the U.S. from the
Enola Gay in 1945 destroyed three-fifths of the city and killed
approximately 75,000 people. The most common rat ionale for
the destruction is that in dropping the bomb, the war was
ended, thus saving perhaps one million military lives in the
long run. The clip you hear is an eyewitness account of the
devastation by a nurse stationed in Hiroshima.

D 9 &

62



P 26

10. Hitler. Adolph Hitler was known for his rhetorical abilities.
This excerpt is from a speech delivered to political leaders of
the National Socialist Party in 1938 in relation to Danzig. The
text is as follows:

“In these fifteen years you have never once doubted of
Germany's future and above all else, you have resolutely given
me your confidence. For the first time in the midst of my old
loyal revolutionary guard, | can welcome these comrades of
ours from the East Mark who have shared in our fight. They
stand amongst you, my old fighters, they cannot be
distinguished from you. The same brown uniforms, the same
flag, and above all the same outlook and the same loyal
German heart. For just as long as the political fighters of the
National Socialist Movement have striven in the Old Reich so
long have they striven in The East Mark. Just as the fighters in
the Old Reich had to lead the onset against a world of
opposition, so precisely was it with the fighters of our East
Mark. From suffering and care they, too, have come and are
now merged in our great German community of the people, in
our new Great-German Reich for now and all eternity! You
will all among yourselves know how strong we are in this
community, at a time when there are clouds in the heavens, |
feel myself doubly fortunate to know that surrounding me are
thous millions of the guard of fanatic National Socialists whose
ranks none can break, whose spirit draws from you its
inspiration, whose leaders you are!

Just as in the long years of the struggle for power in
Germany, I could always rely on you-I know it-today Germany
can, | can, rely on you! You have been tested and hardened in
these long years, you have learned by experience what strength
dwells in a community which is indissolubly bound together,
which carries in its heart an unwavering faith and is
determined that it will capitulate to no one. So it is that you
today make it easy for me to be Germany's leader.

All those who for fifteen years reckoned on the collapse of
our Movement, have been disappointed. From every danger
we emerged stronger. All those who today hope for a
weakening of Germany will suffer disappointment.

When | speak to you in this way, then in you | see not the
140,000 political leaders who stand before me but the German
nation. A people is not more and not less than its leadership.
But our leadership must be good-that we promise to the
German people.”
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11.Japanese Surrender. The atomic bomb was dropped by the
U.S. from the Enola Gay in 1945. As a result of the atomic
destruction of Hiroshima and Nagasaki, Japan sued for peace
on the condition that the emperor's position as sovereign ruler
be maintained. On September 2, 19435, Japanese
representatives signed the formal document of surrender on
the deck of the U.S. battleship Missouri, anchored in Tokyo
Bay.

12.Korean War Conference. At a Paratrooper conference
during the Korean War, Lt.Col. McPheron briefs the troops.

13.Lindbergh. Charles A. Lindbergh was the first person to fly
across the Atlantic in 1927. On May 20, 1927 at 17:52 a.m.,
he left Roosevelt Field, Long Island, NY and landed in Paris at
10:22 p.m., French time, on May 21, thirty-three and one half
hours later. This clip contains a description of Lindbergh's
arrival home from his historic flight.

14.Lyndon B. Johnson on Vietnam. In 1965, President Lyndon
Johnson began to escalate U.S. involvement in Vietnam. In
February, U.S. planes began to bomb in the North, with [roop
strengths increasing to 500,000 by 1968. The escalation failed
to win the war. In March of 1968, Johnson announced he
would end the bombing and not run for re-election. The clip
records LBJ's views on the war early on, in which he calls the
war one of “unparalleled brutality”.

15. Martin Luther King, Jr. In this clip, the grear Civil Rights
leader speaks on history, its scope, its relevance to his time,
and the struggle of the U.S. and its people. Here, too, he
foreshadows his untimely death. The famous “I have been to
the mountaintop” speech was delivered in Memphis.

16. Mohandas Gandhi. Known to all as Mahatma or “great soul”,
used his philosophy of non-violent confrontation to lead India
to independence and to influence political activists
throughout the world. A portion of his “Spiritual Message”
can be heard on the disc. In was recorded in 1925.

17.Moon Landing. Launched July 16, 1969, Apollo 11 made the
first manned lunar landing on July 20. Lt.Col. Michael
Collins orbited the Moon in Columbia, while Neil Armstrong
and Edwin E. Aldrin, Jr. touched down on the moon in the
lunar module. Armstrong stepped on the surface at 10:56,
and, with Aldrin, erected the American flag on the surface,
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collecting rock and soil samples. They returned to the Earth,
landing in the Pacific Ocean on July 24, 1969. The sound clip
on the disc conrains eyewitness accounts both on the moon and
at Mission Control.

18.P.T. Barnum. Showman, Journalist, and popular lecturer, P.T.
Barnum can be heard here on a recording made by Thomas
Edison.

19.Segregation At Little Rock. From a press conference with
Governor Orval Faubus on School Desegregation in Little Rock,
Arkansas in 1957, this clip demonstrates that the same problems
went on in 1957 as in the period of reconstruction almost 100
years earlier—those of states rights and racial oppression.

20.Sir Edward Shackleton. A member of the 1901-1904 expedition
to Antarctica led by Roberr Falcon Scott, Shackleton returned to
the area in his own ship in 1908. On an expedition in 1914, the
ship was crushed, although the party escaped.

21.The Square Deal. Theodore Roosevelt's aggressive foreign and
domestic policies won him the Nobel Peace Prize in 1910, In
this clip, he promises a “square deal for every man and every
woman” promoting his progressive politics.

22.Theodore Roosevelt. In his “Farmer and Businessman” speech
given in 1908, Roosevelt launched a campaign to break trusts
and conserve natural resources.

23.Thomas A. Edison. One of the first of Edison's recordings
stemming from the invention of the dynamo.

24.Truman On War. This speech, delivered in 1945, foreshadows
the naming of V-E Day, or Victory in Europe Day on May 8,
1945. In it, he promised that *America will continue to fight for
freedom”.

25.Winston Churchill. An inspirational message to his people,
Ocrober 13, 1945.
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